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COMMAND.COM
By George A. Lakes, President,

The nominating committee is making good progress
in filling the club’s needs. See report elsewhere in this
issue. I personally thank them for all of their efforts. We
need more volunteers to run SIGs. We have been averaging at least one per week, which computes to a minimum of four plus per month. Please consider becoming
a moderator.
We would like to compile a list of volunteers who
would be willing to stand-in as a SIG leader when a
given moderator cannot do the scheduled SIG because
of illness or other personal demands that may arise. The
more volunteers, the fewer SIGs they may be scheduled
for. If we don't find more volunteers, we may have to
cut back on the number of SIGs presented each month.
Please check with Ralph Duchacek or Helen Long if
there is a way you can be of service. Remember, you
don't have to know everything about a given program.
As a SIG leader, you may all learn more through attendee participation.
Now for a bit of good news, Jim Thornton has
agreed to take charge of the 2001 garage sale for our
July meeting. As you will recall, Jim was the coordinator of last year’s successful endeavor.
In keeping with the suggestion from members that
we limit the size of our official pages including COMMAND.COM and Executive reports, to be no more
than two pages, I am keeping my column to a minimum. Enjoy!
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Executive Committee Meeting Notes
March 2001 By Laura Pacheco
The Executive Committee meeting was held at George
and Arline Lakes’ home in Oxnard at 7 p.m. on Tuesday,
March 6, 2001. Attending the meeting were George, Arline,
Toby Scott, Helen Long, Craig Ladd, Art Lewis, John Godwin, Ralph Duchacek, David Minkin, Ken Church, and myself, Laura Pacheco.
Financial, Membership, Web, SIG, and President’s Reports are represented elsewhere in TOE.
New Members this month are Helen Jackson and Martha
Churchyard. Welcome, ladies!

A CIPCUG benefit: O’Reilly discount
In celebration of the one-year anniversary of the O’Reilly/
Pogue Press collaboration on the “Missing Manual Series,”
O’Reilly is extending a special discount to user group members through May 13: Order direct from O’Reilly and receive
25 percent off all books in the “Missing Manual Series.”
In particular, members might be interested in “Windows
Me: The Missing Manual” and “Windows 2000 Pro: The
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Craig Ladd reports that Randy Whittle of Microvision
<www.Microvision.com> is scheduled for our April meeting.
The board took a great deal of time to discuss e-mails
sent by members and computer-related sources. The board
appreciated all suggestions submitted and will take the time
to consider them.
Aside from the fact that my computer did crash last
month, I was instructed to cut down on any redundancy in my
minutes/transcriptions. Soooo, see you at the April 6 meeting.
Missing Manual.” This is an extra 5 percent savings above the
regular user group discount of 20 percent.
To order, call (800) 998-9938 and ask for Customer Service.
When ordering, be sure to give the customer service representative this discount code: UGMM
For product information, go to <www.oreilly.com>. This
discount is not offered on orders placed online.
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Programs, SIGs: MicroVision coming in
Programs

April door prizes

The April program will feature Randal Whittle presenting one or more of the MicroVision Development
products: SureThing CD Labeler, WebExpress 3.0, Word
Express, and SureThing Office Labeler.
MicroVision Development specializes in what it calls
software “that makes you look your best. Whether it is
printed or electronic media, labels, business cards, memos
or web pages, MicroVision helps you add expression to
your personal and professional communications.”
SureThing CD Labeler is the market-leading software
for creating CD-R and media labels, making use of SmartDesigns to quickly accomplish attractive, professional designs.
Interested in putting together a Web site? WebExpress
is, the company says, the easiest choice, without compromising a bit of power. John Dvorak said, “This is without
a doubt the best Web-page layout and development tool I
have ever seen. It kicks the stuffing out of FrontPage.”
WordExpress, the company says, “is the perfect midrange word processor and desktop publisher” and offers
“a perfect balance of power and ease of use.”
SureThing Office Labeler was formerly known as DesignExpress for Labels and is, the company’s Web site
says, “by far the easiest to use, most versatile, and produces the highest quality output of any of its competitors.”
If you want to know more about MicroVision before
the program, the company’s Web site is at <www.mvd.
com>.
The meeting will be at the usual time and place: 9:30
a.m., Saturday, April 7, at Freedom Center, Camarillo
Airport, 515 Eubanks (at Pleasant Valley Road),
Camarillo. Doors open at 8:30 a.m., and the Internet and
Beginners SIGs will start at 8:45 a.m.
Other programs coming up:
May: Adobe
July: Second Annual Garage Sale of the Millennium
(see more information below)

Garage sale in July
The Second Annual CIPCUG Garage Sale of the Millennium is coming.
It’s year two of the new millennium and time for the
July 7 annual CIPCUG Garage Sale. Come to this special
sale where you can buy used computers, printers, monitors, multimedia, modems, memory, games, education
software, digital cameras, tape cartridges, supplies, books,
furniture and more from fellow club members.
This special event will be held after the regular Q&A
session at the July meeting from 10:30 a.m. to 12 noon.
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The door prizes are going to be:
Line Interactive Uninterruptible Power Supply (350
watts, 625 VA)
Optical Internet Mouse (4-button, 2 wheel)
We have two types of prizes, those from the presenter
and those we buy. If the presenter has prizes, members will
get one free raffle ticket; if the presenter does not have any
prizes, there is no free ticket. Tickets for the prizes listed
above are $1 each or six for $5.

SIG reminders
available by e-mail
To keep members up to date on coming SIGs, Andy
Toth has agreed to offer an e-mail reminder service to club
members. Sign up and he will automatically send you a reminder about two days before each SIG, indicating the
topic, location, and date.
We hope that this service will remind more people
about coming SIGs. Check the front page of the CIPCUG
Web site in the “Latest Page Revisions” or at the bottom of
the SIG INFORMATION page.
Or, if you want to sign up without going to the Web
page, send an e-mail to <siginfo@cipcug.org> with the subject line “subscribe” to be placed on the list.
Watch the next issue of the TOE for more details.

March and April SIGs
Special Interest Groups (SIGs) are sponsored by CIPCUG and are taught by volunteers from the membership.
There is no charge for members to attend the SIGs, just a
willingness to learn and share.
Most of our SIGs are held at the Gateway Computer
store, 1700 Ventura Blvd., in the Oxnard Auto Center
(behind the Red Lobster and Fresh Choice Restaurants).
They are held from 6:30 to 8:30 p.m., and we must vacate
the premises promptly by 8:30 p.m. Other SIGs are held at
Ventura County Computers, 2175 Goodyear Ave., No. 117,
Ventura (Toby Scott’s office).
Be sure to check the location for each SIG. If no moderator is listed for a SIG, it is not officially scheduled. Check
the Web page before you attend such a SIG to make sure a
moderator has been found.
Here’s the schedule for the end of March and the month
of April:
Thursday, March 29: HTML, Ventura County Computers, 6:30-8:30 p.m. Andy Toth will lead a Q&A on HTML.
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Q&A: How do I network my computers?
Reported by John Weigle
Secretary Laura Pacheco couldn’t attend the March meeting, and at the last minute the program was announced as a
double question-and-answer session, so the editor stepped in
and prepared this report. Unless otherwise noted, Toby Scott
answered the questions. (In several cases, related questions are
grouped together rather than being scattered throughout the
report to make it easier to follow the discussion.)
Q. How can I network several computers at home?
A: This task is easier than it was just two years ago. It’s
not simple, but it shouldn’t be beyond anyone in the room with
the right directions.
You’ll need a network card for each computer, cables to
plug into the cards, and probably, depending on what you
want to do, a way to connect to the Internet.
If you want to connect only two computers, you can do it
with Category 5 cable with RJ45 connectors configured as a
crossover cable. Unless you have special tools, you’ll have to
buy the cable, or call us at Ventura County Computers and I
can make it for you. You’ll be limited to a distance of 328 feet
because that’s as far as the signal will carry.
For more than two computers, you must use a hub and
straight, rather than crossover, cable, also Category 5. Plug a
cable into each network card and then into the hub. If you get
lights on both ends, the connection is working.
You can cascade, or connect, hubs to each other to add
more computers. You plug into the LAN link to connect hubs
to hubs.
If you have a high speed Internet connection, you also
need a router (a dedicated-purpose computer) to route from
one network to another. The router knows everything below it
(what’s in your home), and it knows how to connect to the
Internet to push data up to other routers. Several vendors sell
dedicated routers for under $200. You plug it into the Internet, plug your fast Internet connection into the WAN port and
plug your computers into the hub connected to it.
You can attach a printer to the network if you purchase an
SMC hub for this because it also has a parallel port to plug the
printer into.
To make the computers talk to the router, right click on
Network Neighborhood, go to Properties and install TCP/IP
for your network card if it’s not already listed. Left click on
the network card TCP/IP, and select “Obtain an IP Address
Automatically.” If you change anything, you’ll need to reboot.

Go to the Start Menu, select Run and type in winipcfg.
That will bring up a box that shows your IP addresses. By default, if you have a modem, it’s the first IP address listed (it
will be called a PPP device). Select your network card, which
may be under the name of the card or the more generic NDIS
driver title and click on it to see its IP address. If your IP address starts with 192.168 you got the address from your router
and you’re almost set. Type the number of the gateway into
your browser in the Address line, and it will take you to a configuration page for the router.
The documentation for your high-speed connection tells
you what kind of IP address you have: static, dynamic or
PPPoE (Point to Point Protocol over Ethernet). Tell the router
what kind you have, put in the password and username you
got from your connection provider. Once you’ve connected,
the router will know how to do everything else as long as your
computer is on and connected to the Internet.
(Andy Toth points out that the instructions that come with
routers are usually quite clear, and Toby agrees.)
Q: Can a computer with Windows NT network with
one with Windows 98?
A: Yes. You could also network a Mac and a Linux computer in the same network.
Q: If I use a router with a dial-up connection do I
have to use an external modem?
A: Yes. Be careful which router you buy because some
don’t have serial connections. If you don’t do that you’ll have
to use something like Internet Connection Sharing, which
comes with Windows 98SE, Me and 2000, and use the internal
modem on the gateway computer. Everyone else has to plug in
to the gateway computer.
Q: How about using phone lines or electric lines to network? What about wireless connections?
A: I don’t know of anyone who has successfully used
electric lines for a reliable connection. Phone lines work OK. I
have a 3Com USR Phoneline at home and use a Pentium 133
as a dedicated router. You can’t connect this to a DSL because of the plugs. My computer and the router will automatically pick up IP address changes when they change. The two
other computers don’t. When this happens I have to reboot
those computers or run winipcfg again.
I haven’t tried the wireless yet but have read some reviews
that say it’s not ready for prime time and others that say the
(Continued on page 6)

More on programs and SIG schedule …
Word, Back to Basics.
If no questions surface, Andy will plunge into frames.
Thursday, April 19: Ventura County Computers, Toby
Monday, April 9: Gateway, Mike Shalkey, Internet Travel Scott, Internet Financial Sites.
Opportunities.
Thursday, April 26: Ventura County Computers, Andy
Tuesday, April 17: Gateway, Alexandra Zuromski, MS Toth, HTML Q&A.

(Continued from page 3)
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More Q&A: Magnets on floppies, virus issues
(Continued from page 4)

newer versions are better. I probably will install it sometime
down the road.
Q: At school, a science teacher explained how to check
for steel by using a magnet. Some of the students checked
a floppy disk. Can the disk be reformatted and used?
A: It depends on how strong the magnet was. Floppies
have tracks that are not supposed to be destroyed. If they
were, you probably won’t be able to use the disk. Even if it
can be used, at the price of floppies, I’m not sure it’s worth it.
At Comp USA I “bought” a box of floppies for $19.95 with a
$20 rebate (or similar figures). Even if you have to pay 25
cents a floppy, it’s safer for the data.
Q: I’m interested in getting a projector for presentations. What specifications should I look for and what will
it cost?
A: Projectors are expensive. The one we bought for the
club would cost $5,000 to $6,000 retail, and we got it as a
closeout for $3,600, plus the case. Normally, I can get them
for about $5,000. The specs are determined by the size of the
room you’ll use it in. For a room this size, you need a 1,100lumens bulb. For a typical conference room (20 by 15 feet
with an 8-foot table) you need 700 lumens, and the projector
will cost $1,200 to $2,000.
Q: I have a machine with Windows Me that has both
Works and PageMaker on it. Spell check won’t work in
either one of them.
A: I’m not sure what’s happening. You might try reinstalling the programs to see if the spell check files are corrupt.
Comment: This week I had three urgent e-mails concerning new viruses; all were hoaxes, as most such messages are.
If you get such a message and haven’t already heard about
the virus on the national news, chances are good the message
is a hoax (although not necessarily perpetrated by the person
who sent it to you). The key to avoiding viruses is this: Don't
open attachments to e-mails, even if they’re from people you
know, unless you’re certain the attached file really is something you want. Many virus programs send messages to everyone in the infected machine’s address book with a general
message like “Here's the file I promised,” so the sender is not
a guarantee that the attachment is a safe one.
A current real virus is W95.Hybris, which puts a pinwheel
on your screen and changes a variety of system files. Removal
instructions are on the Symantec and McAfee Web sites but
are complex. If you start having problems with the Winsock
file, it could be a sign you’re infected. We can remove the
virus, but it’s a $30 job so it’s better to avoid the infection.
If you have an antivirus program and keep it up to date,
you can detect most viruses before they do any harm. I don’t
keep my antivirus program running all the time, but I also
don’t open any attachments until I’ve checked them. I dump
most attachments without even checking them. I’ve never
been infected, although I have received both the Melissa and I
Love You viruses multiple times, and possibly others I don’t
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even know about because I dumped the attachments.
Q: Could a JPEG file have a virus that I could get by
opening it?
A: Not if it’s truly a JPEG, but you might not be able to
tell for sure. The default Windows installation hides file extensions (such as .exe, .vbs, and .com, all of which are program files). You can change the settings to show the file extensions by going to Windows Explorer > View > Folder Options > View and click on “Hide file extensions for known file
types“ to turn off that option (remove the check from the
box). Now you’ll see the full names of your files and know
that one of the latest viruses, annakournikova.jpg.vbs is really
a Visual Basic script and not an innocent JPEG.
Q: How can I tell if I have a boot sector virus or if the
hard drive crashed?
A: Many BIOS’s have an option to watch for boot sector
viruses. If you suspect you have one, turn that on. The virus
checker that runs off CMOS is pretty good at finding boot
sector viruses. If you have a write-protected boot floppy
from your antivirus program, boot from that. It should catch
any virus.
If you get a boot sector virus it’s very hard to remove,
and you can’t do it while Windows is running.
Q: I just put in a new motherboard that lets me writeprotect the BIOS. During the POST, it says “Flash BIOS
unknown.” I assume that’s because it can’t write to it.
A: I’m not sure. I haven’t seen that. It could be to prevent
virus attacks that overwrite CMOS settings, but it would be a
problem if your battery died. You’d have to change the
jumper settings to put the BIOS settings back. That could be
a small price to pay to stop the BIOS overwriting.
Q: I understand that Windows XP has eliminated
DOS. If that’s so, how can I work in DOS to get rid of a
virus?
A: Boot to a floppy with an operating system and work
from that. Windows Me and 2000 make it harder for viruses
to infect files because they won’t let any program replace files
in c:\windows and c:\windows\system folders. That’s why
you can’t install America Online 5.0 Titanium on machines
with either of those systems. It tries to overwrite a number of
Windows files.
Q: Netscape sometimes shows JPEG files in my messages and sometimes not. Why?
A: It depends on how it’s sent to you. If it comes as an
attachment to plain text, all you’ll see is the link to the attachment. If it’s sent as part of an HTML document, it will show
up.
Q: I create e-mail messages in Word 2000. They used
to be sent by Outlook Express when I clicked send, but
now they go through Outlook 2000. How can I get the default back to Outlook Express?
A: Open Outlook Express and when it says it’s not currently the default e-mail program and asks if you want it to
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More Q&A: E-mail problems,printer garble
(Continued from page 6)

be, say yes.
Q: I had trouble accessing my e-mail with Outlook
on CIPCUG. I can’t download all of them and get a POP
Server error message. How can I find out what the messages mean and why do they come up intermittently?
A: Call me and I can get the message out of your mailbox. It probably came in when there was some kind of hiccup in the system. A week ago Friday, we had an uninterruptible power supply blow up on the server and it took
about an hour to get things back up and running.
Q: What makes my printer print machine language
(strange characters or one large letter per page) and
what can I do?
A: When you turn on the printer or otherwise initialize
it, the printer and computer establish protocols to talk to
each other. If you lose the synchronization, the result is garbled. You’ll probably have to turn the printer off and on and
possibly reboot the computer, too. If your printer requires
the downloading of fonts, as many laser printers do, you’ll
have to repeat that process. If you have a paper jam or other
problem, try to pause the printer rather than turning it off,
and you might avoid such problems. This problem is more
typical with laser printers than with inkjet printers. It can
also arise if you send a very large page to the printer and the
printer doesn’t have enough memory to hold it.
Q: I’m installing a new hard drive but want to use
both of them. Which one should be master and which
one should be slave?
A: The master drive must be bootable. If it already has
Windows installed, you make it the master to start with. If it
doesn’t have an operating system, you’ll have to make it the
slave, put the operating system and whatever else you want
to copy from the original drive on it and then make it the
master. You generally want the faster, newer drive to be the
master drive. You can drag and drop the files you want to
put on the new drive with Windows Explorer.
Q: How can I change my default browser to Internet
Explorer?
A: Open IE and when it asks if you want it to be the default browser, say yes.
Q: I’m also having some other problems. I installed
Windows Me as an upgrade over the old operating system. At first it was OK, but now it isn’t, and I get a lot
of freeze-ups.
A: Installing Windows Me over Windows 98 doesn’t always work. The best approach is to do a fresh install in a
new directory. Rename Windows to something like Winold
so you or someone else will know what you did and then use
the default installation of Me. As an alternative, when Me
says it will install in c:\windows tell it to install in windowsme, instead. The Windows Me upgrade installation program will search your drive for the old Windows and ask if
you want to install over it. Say no and give it the alternate
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directory. The advantage of keeping the old system is that
you can go back to it if the upgrade installation doesn’t work
for some reason.
To do this, go to DOS at bootup. Rename the Windows
directory Winold. Reboot and enter the CMOS set-up
(watch the screen for instructions or, better, write them
down before you rename the Windows directory, just in
case). In CMOS, change the boot order so the machine will
boot from the CD-ROM (look for CD-ROM or ATAPI device). Put the Windows Me CD in the CD drive, reboot and
the CD will come up. This also works for Windows 98,
98SE, 2000 and NT4.
Another advantage to putting Me in a new directory and
keeping the old OS is that Me doesn’t work with all the
older hardware, and sometimes there’s no way to be sure it
will work with yours except trying it out. The lists of compatible hardware aren't complete. If your hardware doesn’t
work with Me you want a way to go back to the old system
without starting from scratch.
After you’re sure all your programs and hardware work,
you can delete the Winold directory.
No upgrades are guaranteed to go smoothly. I have a fair
amount of experience doing them and still have problems
with 1 out of 10.
Q: If I install Windows in a new directory do I have
to reinstall all my programs, too?
A: Yes, but this isn’t all bad. Your old registry has
probably grown quite large as you’ve added and removed
programs, and starting fresh will cut it down considerably.
Chances are that even if you install over the old directory
you’ll have to reinstall about half the programs anyway for
one reason or another.
I have to reinstall Windows and programs about twice a
year even if I’m not changing the operating system for the
same reason. I download, install, test and uninstall a lot of
programs, and starting fresh periodically is the best way to
clean things up.
Q: I use System Commander when I’m installing
new operating systems. I have partitions for DOS, Windows 98 and Me and Linux.
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More Q&A: Problems with Netscape, Explorer, AOL
(Continued from page 7)

A: That works, as do other boot managing programs. If
you’re going to install several operating systems, be sure to
put each one on a different partition, not just in different directories. If you have them all on the same partition, you’ll
ultimately run into problems.
Q: I upgraded Netscape from 4.75 to 4.76 and am
having lots of trouble with it.
A: No one else had any experience with this upgrade,
and Toby wasn’t familiar with it, but he discussed his experience with Version 6. It “doesn't work like any other software.” By the time all the tool bars and tabs open up, the
screen space left for the Web page you’e browsing is too
small. There are probably ways to eliminate a lot of the clutter, but it wasn't worth the learning curve to me, so I use it
now only to check how it displays Web pages I design.
Netscape is now owned by AOL, but AOL uses Internet
Explorer as its default browser and “what does that tell
you?”
(Many users have reported a rash of problems with the
latest Netscape. Check winmag.com or zdnet.com for some
reports. — Editor)
Q: I have a friend who’s switching from AOL to another Internet Service Provider (ISP). Will we
need to install a new browser?
A: Maybe. AOL modifies Internet Explorer,
and those modifications may or may not work
with other providers. The only way to be sure is
to test it. Copy the dial-up information from your
computer and make a new dial-up connection on
your friend’s computer. Dial in and see if everything works. If so, you’re in good shape. If not,
you’ll have to try a new install. Again, the AOL
version is hard to uninstall (as is all of AOL). Try
upgrading to the latest version of Internet Explorer. If that doesn’t work, you’ll have to go to
DOS and manually extract files from the CAB
folders and install them or reinstall Windows.
(Fred Langa, who writes for winmag.com and
does an excellent e-letter has written several
articles on the changes AOL makes to Windows
system files. Check them out if you want to attempt making the manual changes. — Editor)
Another option, suggested by another member, is to switch to Opera, which now has a free
version if you can live with a small ad box. Toby
agreed but noted that Opera isn't always standards-compliant in showing Web pages.
Q: I’m having a problem with Word
2000. If a create a new document and put in a
hidden comment, as soon as I type
“I” (without the quotes), I get an illegal operation message. If I type “I” before the hidden comment, it works fine.

Page 8

A: I’m not sure, but you might try turning off autocorrect, which is in both Word 97 and 2000. There might be
something in it that creates the problem.
Another member said he’d had a similar but not identical
problem and figured out that a key was sticking and starting
a program he didn’t want.
Toby said that could be an answer and said that the best
way to check such problems is to swap out what you think
might be the offending part. Try a new keyboard, a new
monitor, a new modem, a new video card, etc. (depending
on the problem, of course). If you don’t have the parts,
you’ll need a friend who does or have to take the computer
into a shop. That’s often the reason Toby advises people to
take a computer into the shop, he said, because they have
parts to swap for tests.
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Have you backed up recently?
If not, just remember that
computer crashes are not a
matter of “if” but “when.”
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Bits and bytes: Library rules, other business
Library update
Librarian Arthur Jensen has been updating the library and
culling the outdated material. Here are his guidelines on what
he’s keeping and what will and won’t be accepted as donations:
No user guides (they’re part of an original software package).
No books with copyright over six years old, unless they
hold special value.
No software packages. The library, by board policy, does
not deal in software.
No books/disks that are of such a specific nature as to
hold no member interest.
Arthur has also updated the library sign-in and sign-out
procedures, which allow members to check out books and
other material and is selling donated books that won’t be kept
in the library for $1 each at the next meeting.

Business not covered elsewhere
During the regular business meeting, the following items
were mentioned:
Please continue to save empty ink cartridges as part of the
ongoing fund-raiser for the club.
One of the refill dealers buys them from us for use in demonstrations.
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Another case of “Secret Guide to Computers” has been
ordered and should arrive by the next meeting.
Charter member Bob Burnett recently had a serious heart
scare. His Pacemaker was trying to deal with his heart’s fibrillation, and his blood pressure dropped to 80/40.
He spent three days in the hospital. His e-mail address is
oburnett@juno.com if any of you would like to drop him a
line.

Requests for reviews
We have had requests from several companies, including
Xerox, inKline Global Inc. and Mystik Media to run reviews
of their products.
InKline Global and Mystik Media apparently offer a variety of shareware, judging from their e-mails. The Xerox email was not entirely clear on what products they want reviewed.
We have asked for a CD-ROM with the inKline products.
Editor John Weigle will bring a printout of the Mystik Media
e-mail to the next meeting and will ask Xerox for more details
on what they’re looking for and bring a printout of that to the
next meeting.
Meanwhile, if you’re interested in doing such reviews,
send an e-mail to <editor@cipcug.org> so we have an indication of interest. Thanks to all of you.
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Web page: Lots of pictures are up
By Helen Long
<helen@cipcug.org>
I have added more pictures to the “Club Photos 2” page and a
few more for the “Behind the Scenes” page. Have a look and see if
you are there. A big thanks to Jerry Crocker for his continued support of CIPCUG, to help show what we are all about.
I understand that Jim Thornton is going to head the Garage Sale
July 7 Blockbuster event. Have a look elsewhere in this newsletter
for the details and start rummaging around for those hardware items
that have been replaced and the old ones are simply laying around
collecting dust.
Andy Toth has been doing a great job with his SIG messages.
If you are one of those people who can’t remember when SIG meetings are, sign up for Andy’s message reminder. It is at the bottom of
the Page Revision section on the front page of CIPCUG.ORG. It is
also available from the Siginfo page just after the SIG listings. Let
Andy tie a string around your finger to remind you of the next SIG.
He sends the notices out about two days prior to each SIG. Currently, he has over 25 people on his mailing list, but we should have
many more than that. Sign up today. Try it! You'll like it!

April 2001

The CIPCUG ISP has been
humming along at a comfortable
pace. We have encountered no major
problems at all. ISWEST has
worked out a neat arrangement in
that it provides a Pac Bell line and a
GTE line to most of the cities in
which they have service. This means
that if Pac Bell is working on a line
and service is disrupted, you have
another dial-up number to use that is
GTE. The chances of both GTE and Pac Bell being interrupted at
the same time are remote. Our rates are only $15 monthly, plus a
$15 sign-up fee. Come and join us!
What are TeX, LA TeX, Bib TeX, Kluge, Ad-Hockery? Check
out FOLDOC (#31) on Ronnie Ray’s favorites. It is an interesting
computer dictionary. Cyber Atlas (#29) indicates that for the first
time in the history of the electronic messaging market, there are
more electronic mailboxes outside the United States than within it,
according to Messaging Online. March 12, 2001, and many other
interesting research results including Top 50 Sites according to PC
Data online for March 8, 2001. If you haven’t visited Ronnie Ray’s
Favorites, you are missing out.
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Membership report: Is it time to renew?
By John Godwin
Welcome to the following new member: Martha Churchyard
Total membership: 354
Attendance at the March 2001 General Meeting: 104
Members, 5 Visitors

Renewal Information
The renewal dues are $25 single membership, $30 for a
two or more family membership.
Please send renewal payments to:
CIPCUG MEMBERSHIP
P.O. BOX 51354
OXNARD, CA 93031-1354
Or you can make payment at the monthly General Meeting.
February 2001 renewals due:
Member #
914
663S
180
912
179
842
306
297
658
187
98

Last Name
Alderson
Craig
Daily
Krinsky
Lee
Menees
Presutto
Sabatka
Skeeters
Tracy
Vlazny
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Last Name
Anderson
Bak
Bennett
Birkett
De Wolfe
Dirrim
Falconer
Goodwin
Guyton
Johnson
Kelly
Kimball
Lakes
Lakes

Last Name
Lee
Lewis
Marcovitz
Marcovitz
McLoud
Nifong
Phelps
Ross
Thornton
Thornton
Van Sickle
Vaughn
Volpe
Willson
Yates
Zuromski

First Name Paid to Date
Terry
200103
Simone
200103
Morton
200103
Betty
200103
Jerry R.
200103
Robert
200103
Patricia
200103
Donald
200103
Dianna
200103
Jim
200103
Michael
200103
Connie
200103
Victor
200103
Martin
200103
Jeffrey
200103
Alexandra 200103

April 2001 renewals due:

First Name
Bev
Wallace
John
Richard
David
Ralph
Joseph
Edward F.
Cline
Bob
Don

Paid to Date
200102
200102
200102
200102
200102
200102
200102
200102
200102
200102
200102

First Name
Arvid
Chan
LeRoy
Ken
Terry
Allen
Margaret
Maggie
Wayne
Barbara
Scott
Eugene
Arline
George

Paid to Date
200103
200103
200103
200103
200103
200103
200103
200103
200103
200103
200103
200103
200103
200103

March 2001 renewals due:
Member #
963
853
858
960
669
667
1016
1018
426
917
573
1011
138
137

Member #
066
859
1014
1015
100
768
423
177S
221
136
575
1017
430
1013
1012
771

Member #
688
1020
687
776
964
775
439
202
965
1021
918
210
317
676
142
452
919
1019
868
777
967
332
864
966
863

Last Name
Arriola
Barrett
Clark
Darnielle
Faue
Gleeson
Jeffreys
Kleeburg
Kreitzer
La Madrid
Leighton
McMurray
Mulligan
Pearson
Peck
Simon
Sundberg
Teperow
Webster
Williams
Wright
Wright
Wright
Wright
Zapf, D.P.M.

First Name Paid to Date
Kirby
200104
Margaret
200104
Lewis
200104
Jack
200104
Warren
200104
Bill
200104
Robert
200104
Hank
200104
Shlomo
200104
Victor
200104
Charlie
200104
Richard
200104
Champ C. 200104
Floyd
200104
Darrell
200104
Hal
200104
Ralph
200104
Beverly
200104
Ed
200104
Shirley
200104
Ward
200104
Don
200104
John
200104
Margaret
200104
Michael
200104

You can always determine when your membership
expires by checking the code on your mailing label on The
Outer Edge.
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Computer-related radio programs
By Jim Thornton
<jthorn@gte.net>
Here is a revised list of the locally heard listener call-in personal
computer-related radio programs; the previous list was published last
year about this time.
There have been several major changes to these programs — one
program has been moved from Sunday to Saturday and another station has completely dropped its computer program. KLSX and
KTMS both dropped the third and last hour of their “Komputer
Klinic” show, the two-hour Sunday afternoon “The EarthLink Network Internet Show” has moved from KLSX to KRLA, KABC
moved its Sunday morning “The KABC Computer Show with the
Marck Brothers” to Saturday mornings, and KVEN dropped the entire three hours of the tape-delayed “Komputer Klinic” show.
Saturday
“Komputer Klinic” with Kim Komando
7-9 a.m. on 97.1 FM KLSX (Los Angeles) and 990 AM KTMS
(Santa Barbara). Telephone: (888) 825-5254 (Phoenix). Home
Page: <www.komando.com> and e-mail: <helpmekim@komando.
com>. Remarks: Has a weekly column in USA Today newspaper
and a monthly article in Popular Mechanics magazine, written several books, and produced video learning tape series; provides a free
(but slow) help service via e-mail; publishes a free weekly e-mail
newsletter, and both stations no longer carry the third hour.
♦ “The KABC Computer Show with The Marck Brothers”

♦

with Marc Cohen and Mark Oleesky
10 a.m.-12:45 p.m.. 790 AM KABC (Los Angeles). Telephone:
(800) 222-5222 (Los Angeles). Home Page: <www.kabc.com/
pages/36237.asp> and e-mail: <computershow@kabc.com>. Remarks: If the caller’s question is too technical, they will request the
caller to e-mail the question and they will e-mail the solution.
Sunday
♦ “Jeff Levy On Computers” with Jeff Levy
9 a.m.-12 noon on 640 AM KFI (Los Angeles). Telephone:
(800) 520-1534 (Los Angeles). Home Page: <www.jefflevy.com>
and e-mail: <jefflevy@jefflevy.com>. Remarks: If the caller’s question is too technical, he will call the caller after the broadcast and
provide the solution; provides a weekly computer lesson from his
Web site, and publishes a monthly, for-a-fee, printed newsletter.
♦ “The EarthLink Network Internet Show” with Val Whalin
and Alex Gray
12-2 p.m. on 870 AM KRLA (Los Angeles). Telephone: (800)
392-7447 (Los Angeles). Home Page: <radio.earthlink.net> and email: <internethour@earthlink.net>. Remarks: Specializes in only
Internet-related topics.
♦ “Computer America” with Craig Crossman
12-3 p.m. on 1520 AM KVTA (Ventura). Telephone: (877)
266-7469 (Palm Beach, FL). Home Page: <www.computeramerica.
com> and e-mail: <ccrossman@computeramerica.com>. Remarks:
Has weekly contests with a hardware or software prize per hour.

Frustrated because Word forces you to use Times New Roman?
By Jim Thornton
<jthorn@gte.net>
I prefer to use the more modern font called Universal, and
every time that I write a letter, e-mail, etc., Microsoft Word
always sets the font to its default value of Times New Roman.
Times New Roman is an older style font with serifs, which are
very short lines stemming from and at an angle to the upper
and lower ends of an individual letter. For example, a capital
W using the Times New Roman font has three serifs at the top
of the letter. In addition, some fonts are monospaced, meaning
that every character is the same width. An example of a monospaced font is Courier. I prefer the Universal-type fonts because I find their characters easier to read as they appear to be
clearer and are truly proportional, i.e., the letter W is wider
than the I, etc.
You can easily change Word’s default font from Times
New Roman to any one of the numerous fonts ranging from
Abadi MT Condensed Light to Wingding 3. To do this, just
launch Word and from the File menu, choose Open. In the
Files Of Type box, select Document Templates. Click on the
Up One Level icon until you reach the Windows folder and
then select Application Data. Next click on Microsoft, then
Templates, and select the Normal file. Click on the Open but-

Page 14

ton, select the Format menu, and then click on Font. Select the
font of your choice and click. Click on the File menu and select Save. Click on the File menu again and Close to exit the
Normal file. Finally exit Word and the next time that you
launch Word, the default font will be the one of your choice.
While you were looking at the choice of fonts to choose
from did you notice the small icons to the left of each font
name? What do they mean?
The printer-like icons are fonts that came provided with
your printer, while the double T icons are TrueType fonts, and
their size and appearance are software controlled. Because
your printer can quickly provide its own fonts, documents using these fonts will generally print faster than TrueType fonts.
These latter fonts are provided as part of Word and may be
supplemented by other type managers such as Adobe. These
scalable fonts are generated by software and allow a wide
range of freedom in selecting the size of the font (typically
ranging from 8 to 72 points; the larger the number, the larger
the character), controlling the spacing between characters, etc.
The Internet is a good source for adding more scalable
fonts to documents. One source is <www.fontsite.com/Pages/
FFDownloads.html> for several free downloads to choose
from.
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Digital CD recording hints
By Stan Ranson
I have recorded in excess of 400 CDs over the past two
years using Adaptec’s Easy CD Recording program, version
3.5. I tried the newer version 4.0 but reverted back to 3.5 as
I found it seemed to work a lot better. However, I’m always
looking for new programs as most of my music is either on
78-rpm records or derived from that source. I came across
“Digital CD Recording Studio II (Professional Edition)”
published by Macmillan software and decided to give it a try.
The retail price is $99.95 plus a $20 rebate that you receive
from Macmillan. This price is compatible with Adaptec’s at
$89.95, although I have seen it advertised at $68.95 so
maybe Adaptec has a rebate system as well.
The Macmillan product specifies “Professional Quality
CD Recording and Audio Restoration” so with about 175 of
my 78s being “unrecordable” using Adaptec’s product because the hiss and clicks of damaged or well-used tracks
could not be improved I thought this new program was

manual and listening to/viewing the guided tours, I was
ready to try my first recording. Now, I will admit that I
haven’t mastered all the ins and outs of the program, as
many situations have not yet occurred with the records I
have processed, but I expect them to arise in the future. I
selected five records that seemed to be the worst in the
bunch and recorded them on a cassette, which faithfully reproduced the clicks and hisses from those distorted tracks.
DART Pro 32 allows you to import a sound file from
any source without having to specify whether it’s cassette,
reel to reel, phonograph or whatever. Opening the Wave recording screen, you see a variety of selections:
— Sampling rate 11kHz, 22kHz, 44kHz or “Others”
where you can select your own; however, the default is
22kHz.
— A selection of mono or stereo (I always select stereo
as it will repeat the mono on both channels), plus two col(Continued on page 16)

worth trying. The results will be discussed later,
but let’s first take a look at the new product and
what is required to use it.
The box contains an installation CD and a
168-page manual. Computer requirements include Windows 95, 98, Me or NT, 16 MB RAM
and a 1.2 GB HD, 486 or better CPU, a 16-bit
compatible sound card and a CD-R or CD-RW
drive. Installation took about 10 minutes with no
problems on Windows Me. My next step was to
read the manual cover to cover even though I
knew there were areas that I wouldn’t understand; at least I would know there was a written
reference I could re-examine. The CD and manual are divided into two programs, No. 1 being
the preparation of the music for recording, including the removal of noise, conversion from
mono to stereo or reverse plus some other goodies. This part of the operation is called DART
Pro 32, and the second is the actual recording to
CD, called CD-Recorder 4 Basic. Each program
has its own Table of Contents in the manual with
every highlighted paragraph listed so it’s easy to
find a specific item needed for reference. Also,
an index follows the same approach by listing all
the pages referring to each item. This part of the
manual got a rating of 10 from me, as I hate to
have to look up a multitude of pages to find the
answer to my problem.
After reading the manual, I took the guided
tour that comes on the installation CD. This is a
vocal guide with comprehensive descriptions of
each step. By the time I had finished perusing the
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More on MP3s: Some how-to-do-it tips
(Continued from page 15)

umns depicting dB levels), one for each channel ranging from
0 through -30 dB.
— A set of cassette deck buttons allows you to select
Fast Reverse, Stop, Play, Fast Forward, Record and Pause.
— You can also see how much free disk space you have
(unfortunately this doesn’t change as you use the space), the
number of bytes being used for the recording, also a minute/
second counter. The final button on the screen is the close.
After you hook up the playback system, the recording levels can be checked by playing the source and then clicking on
the Pause button on the screen. The Levels meter will indicate
whether the sound level is acceptable or not. Too high a level
will illuminate the red lights at the top of the meter so if this
happens or just the bottom green level lights come on, the
sound card level must be adjusted. I like to record around
the -12 to -3 area as it maintains the same level on the final
CD throughout the 20 odd tunes and I don’t have to adjust
my CD player. Once you are satisfied with the levels etc.,
you can record the source onto the DART 32 by pressing the
Record button on the screen.
This initial recording becomes the root of the audio tree,
and all modifications are stems from this root; therefore, you
may try various changes and save each one as part of this
tree. Finally you can choose the recording you want to keep
and delete the others.
Most records are corrupted with different forms of damage such as clicks, pops, scratches, tape hiss or surface noise,
and DART Pro 32 offers solutions for correcting these.
DE-CLICK: Eliminates disturbances and wideband noise.
RE-TOUCH: Removes any extraneous disturbances not
removed by D-CLICK.
DE-NOISE: By running a Noiseprint of a section of the
audio file a specific problem can be eliminated.
DE-HISS: Less selective than DE-NOISE and, to my
mind, the best system for cleaning up an old 78 rpm record.
Opening up a source file presents a dual (stereo) waveform (identified as “Source File”) that can be expanded to fill
the screen so the quality of the recording can be observed. A
recording with a high noise value shows a fuzzy waveform,
indicating the noise is overpowering the actual sound. I use
DE-HISS to correct this as it has worked fine for every type
of problem I’ve encountered other than clicks or pops, for
which I have used DE-CLICK. Under the Restore button at
the top of the screen select De-Hiss and you are requested to
set several renovation parameters — these are all set at Normal mode except for Overlay set at Very Large. A test run on
a short sample of the recording is available on this screen to
check on the effect of the settings so you can play the source
and then play the result. Thus, you can make changes to each
parameter and evaluate the result immediately.
The parameters are as follows:
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GAIN: (In DE-HISS only) determines the amount of
noise to be rejected from an audio file. Too much gain and
the audio may become muted or dull. I have found success
using either normal or large in the menu.
WEIGHT: (In DE-NOISE only) is similar to Gain in DEHISS.
SMOOTHING RANGE: A technique to assist in the removal of residual noise. Too low a range, “Very Small” and
the signal will sound mechanical while if you go too high
“Very Large,” the signal may be hollow and lifeless. I use the
LARGE setting.
FREQUENCY CARVING: A simple way to reduce
broadband noise by forcing extra attenuation into the high
range. Can preserve the rich sound of some musical instruments, but use it with caution. Use the “Large“ or “Very
Large” ranges for 44.1 kHz recordings and either “Normal”
or “Small” for 22.05 kHz. I use the Normal setting.
FRAME SIZE: During processing, the signal is divided
into partially overlapping analysis frames. Longer frames
should be used when the signal-to-noise ratio is small and
shorter when the opposite applies. My setting is at “Small.”
OVERLAY: Controls the degree of frame overlapping.
Longer ones are advised. Mine is set at “Very Large.”
When all the settings are final, press the “Process” button,
and the parameters will be applied to a “Destination” file,
which shows as a dual wave form just below the source form.
The processing takes about 1.5 minutes for a 3-minute recording. The most obvious result is the elimination of the
fuzziness on the wave, and the resulting playback puts a smile
on my face as all the bacon frying has disappeared so all I
hear is a 78 rpm record that sounds very similar to the first
time I played it some 60 years ago. A wonderful program!
Now let’s take a look at some of the other aspects. The
recording phase, “DART CD-RECORDER V.4” is, to my
mind, not as good as Adaptec's CD Creator. I found some
difficulty in recording the number of tunes on the CD (27).
The listing would handle only 22 tunes so referred back to
Easy CD Creator 3.5 to make the CDs. Likewise the Jewel
Case insert was just a single page on DART and a three-page
insert on Adaptec so I use this one to make my inserts. As far
as eliminating any areas at the beginning and the end of the
recording I find Adaptec’s program is easier to handle. Needless to say, I intend to master the full DART programs, but I
needed to get this review out before I spend much more time
in trial and error. If I find anything outstanding in the next
few months I’ll write a follow-up. In the meantime I’ve processed 50 records and have only 125 to go and you can bet
they’ll all be processed on this program.
The program is published by Macmillan Software as
“DIGITAL CD RECORDING STUDIO II ... PROFESSIONAL EDITION” with a list price of $99.95 and a $20
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F1—Your Help Key
(Revised Dec. 11, 2000)
CIPCUG INTERNET SERVICE
(For general Internet and Communications programs,
see Communications/Internet)
Jerry Crocker,
486-0308, 6-10 p.m.
normsplumb@aol.com,
Roland Fleig,
983-8707, mornings
schwable@cipcug.org,
George & Arline Lakes, 983-2969, 2-10 p.m.
thelakes@cipcug.org,
Helen Long
642-6521
helen@cipcug.org
David D. Minkin,
484-2974, 5-12 p.m., weekends
dddave@compuserve.com,
Claude Whelchel,
482-4017, 8-12 a.m.
claude@cipcug.org
COMMUNICATIONS/INTERNET (GENERAL)
World Wide Web
DM, TS
Compuserve.
DM
Note Tab Pro.
TS
Procomm Plus
DM, WB
DATABASES
dBASE.
MS Access

GM
LP

DOS

RP

HTML

TS

NETWORKS

TS

OS/2

LZ

SPREADSHEETS
Lotus 1-2-3
Microsoft Excel
Quattro Pro

GM
DM, LP
DM

UTILITY PROGRAMS
Norton Utilities
PCAnywhere
PC Tools .
XTree Gold.

DM, JD
DM
WB
DM

WORD PROCESSING
Microsoft Word
WordPerfect.

BW, DM, MR
DM, GM, JD

WINDOWS
Windows 3.1
Windows 98, 95
Windows 2000
Windows NT

DM, JM
DM, JM
TS
TS

Initials
BW
DM
GM
JD
JM
LP

Name
Bart Wood
David Minkin
d: voice mail
Gracia Marks
John Daily
Jerry McCloud
Laura Pacheco

(805)
482-4993 (e)
484-2974 (e);
339- 1729
484-7572 (e)
650-0029 (b)
(818) 889-6176 (e)
L5Enigma@Earthlink.net

LZ
MR
RP
TL
TS

Len Zakas
388-8452 (b)
Marvin Reeber
984-1974 (b)
Robert Provart
498-8477 (b)
Terry Lee
tdlee28@hotmail.com
Toby Scott
289-3960 (d)
tech@cipcug.org
TZ
Trish Zakas
388-8452 (b)
WB
Dr. William Burger 653-6889 (e)
Phone: (d) = days; (e) = evenings; (b) = both

EDUCATIONAL / CHILDREN TZ
E-MAIL
Lotus:CCMail.
Outlook
Outlook Express

DM
TS
TS

FINANCIAL
Quicken

JD

GENEALOGY

TL

HARDWARE, UPGRADING JM, JD
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Nominating
committee report

Letters: More on
contents

By Ron Pinkerton

I use the transcription of meeting Q&A’s as a selling
point to prospective members who may be too shy to come
and ask their own questions.
From my perspective, the main weakness of the club,
where it shoots itself in the foot, so to speak, is the way the
Internet gets so much emphasis that PC users are considered
beneath notice for any activity, where the established tenets
of journalism are laid waste by “see Web page for details.”
I have the impression that the club would more easily
have a quorum if it were less hostile to non-Web PC users.
Having phone numbers listed in The Outer Edge’s masthead
is a step in the right direction.
The big advantage of the newsletter over attending a
meeting is that any time wasted reading the newsletter is at
the discretion of the reader. That is my comment on a recent
failed presentation.
Thanks for your kind attention.
William Von Wicklen,
Oxnard

Nominating Committee: Ron Pinkerton, Jim Pass,
Roland Fleig and Laura Pacheco.
After several meetings, numerous calls, constant pleading, hair pulling, and the ability to coerce, this committee is
just about finished. With only a few touches by next month,
we should have all the chairs on their way to being filled.
Numerous details made it impossible to complete the report
until this weekend (March 17-18).
We have the honor of Andy Toth’s nomination for president, which as of this date is the only elected board position
to be filled.
As for the Committee Chairs, we have decided that a
committee rather than one person running all over the entire
county should handle the advertising. I don’t know how it
happened, but I am the Advertising Chairperson (Ventura
area). I am honored to have Jim Pass (Simi Valley Area),
Alyce Radocay (Camarillo), and George Brown (Thousand
Oaks/Newbury Park area) working with me. Until confirmation has been made, we will also have at least one other volunteer helping with the Oxnard area.
For Computer Show Chairman, we have Roland Fleig.
Roland has been around computer shows and will be a great
choice for this position.
Jim Thornton has graciously volunteered to be Publicity
Chairman. Jim has a lot of ideas for this chair and we know
he will be great at it.
Last, but definitely not least, we are honored to have
Nita Lang back after a medical leave, and she is raring to get
back to working on the club’s presentations. Welcome back,
Nita.
We will have more updates for you at the next club meeting.

Elections will be
conducted at the June
meeting.
If you can’t attend the meeting, please watch the Web
site for a ballot that can be
voted online.
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Do you have questions
on special effects?
Member Alyce Radocay has contacted Paul Gentry, a
master special effects man who has been in charge of effects
for “The Muppets Christmas” and the movie
“Monkeybones,” who says he doesn’t feel comfortable
speaking to the group but would be willing to write some
articles for The Outer Edge. He replied, “I’m MUCH more
articulate with the written word, so, sure, no problem as
long as your sure people would be interested.”
He has several computers but is mainly an avid Mac man.
We have his e-mail address and phone number, but rather
than print them at this point, we’ll simply ask if any of you
are interested in such articles and, if so, what you’d like to
know. If you are interested, send some comments about
what you’d like to know (specific questions if you like) to
<editor@cipcug.org> and we’ll forward them to him. Knowing what we’re most interested in obviously would help him
figure out what to write for us.

More on MP3s...
(Continued from page 16)

rebate. Log on to <www.dartpro.com> for a free trial download.
(Stan gave me an update to this article at the March
meeting, but I’m trying to get this issue done so rather than
incorporating it here, I’ll run it next month. — Editor)
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Editor’s corner: Mail problems; Web use
I just went through the frustrating experience of opening
my Eudora Pro e-mail program only to find that the In box
index had been damaged. I think – but am not positive – that
it happened when I downloaded and started a new version of
Enfish Onespace.
I couldn’t find a “rebuild index” or “reindex” tool on the
toolbars or in the Help section and tried a couple of things
that didn’t work. I restored the In.toc file from a DataKeeper
backup, but when I reloaded Eudora, it said the index was
damaged and needed to be rebuilt (so why can’t I find a way
to do that manually?). Rebuilding the index didn’t work either: The message headers showed a message from one person, and the preview screen showed a message from someone else. Arrgh!
Finally, I decided to try creating a new mailbox I called
“Garbled index from Inbox” and moved the contents of the
Inbox to it. (You can speed the process up by putting your
cursor in the headers box, hitting Ctrl-A to mark all the items
and then moving them all at once). I checked the messages in
the new mailbox, and the headers and messages seemed to
match, so I moved everything back to the In box. This
seemed to work, although I’m not sure what damage I might
have caused with the earlier experiments, other than possibly
losing some messages that came in after the last backup.
Why do I think Enfish might have been responsible? Because of a message that I read and ignored (dumb, dumb,
dumb!) in the read me file:
“Eudora email
“We have removed Eudora email as an install option for
this release. This is because we have discovered a problem
where larger mail stores can become corrupted with certain
circumstances. If you were a beta tester using Eudora and
did not experience problems, you can add Eudora by going
to Tools | indexing settings | Add Schedule Item. Select Eudora and it will be added to the indexing queue. We are planning to fix this problem and provide a free online update
shortly.
“Some email items may appear with the wrong time
and date stamp in our results list. The integrity of the original
email is not compromised in any way.”
***
We have a longstanding rule at the Star that we generally
don’t answer letters with editor’s notes because doing so
takes advantage of the reader by always gives the paper the
last word. I think it’s a good rule, but I do want to take a
moment to respond here to a letter in this issue.
William Von Wicklen takes TOE to task for the number
of times we’ve said recently to check the Web for more information. I don’t like to do that any more than he likes to
see it, but sometimes I have no choice. TOE has to be prepared and sent to Copy Court (our printer) by the end of the
week after our regular meeting. That gives us time to get it
printed, folded, labeled, mailed and delivered so you have it
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before the next meeting. The Web page, on the other hand,
can be updated daily, if need be, and you can see the changes
immediately.
Unfortunately, we don’t always have information on the
next month’s program or SIGs by the TOE deadline, and on
such occasions, I refer readers to the Web site. Even if we
have the SIG information it’s a good idea to check the Web
page because sometimes a SIG is cancelled at the last minute
(as the OS2 SIG was in March). Not everyone in the club
has e-mail (or has given us an e-mail address), so short of
calling everyone by phone, which isn’t going to happen, we
can’t get messages out regarding changes or updates without
using the Web page.
In a perfect world, we wouldn’t have to do this, but the
world isn’t perfect. And, if you’ve noticed, even newspapers
and magazines are relying more and more on the Web, making some information available only on their Web sites. Like
it or not – and I admit, I don’t always – much of the world is
using the Web as its main information source. As a print
journalist, I’m not thrilled with that, but it’s true. And we
might as well get used to it.
-- John Weigle, Editor

Treasurer's report
Feb. 1-28, 2001
By Art Lewis, Treasurer, <treasurer@cipcug.org>
Income
Advertising
ISP Income
New Members
Raffle
Renewals
Software Sales

$ 170.00
735.00
120.00
144.00
685.00
40.00

TOTAL INCOME

1,894.00

Expenses
Coffee-Doughnuts
10.00
ISP Expense
352.00
Miscellaneous Expense 13.02
Service Charge
2.00
Storage
-12.00
TOE
592.97
TOTAL EXPENSES

957.99

TOTAL INCOME – EXPENSES $936.01
Unrestricted Funds
$5,140.58
Restricted Funds
1,010.50
Bank Balance 2-28
6,151.08
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DUES REMINDER
If the number after your
name is 0104, your membership dues are payable
in April 2001

APRIL 2001 MEETING OF
CHANNEL ISLANDS PC USERS GROUP
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Saturday morning, April 7,
at
Freedom Center, Camarillo Airport
515 Eubanks (at Pleasant Valley Rd.)
Camarillo, California
Meeting Schedule:
0845-0930 Beginners SIG
0845-0930 Internet SIG with Toby Scott
0930-0945 Business Meeting, announcements
0945-1030 Q&A Help session
1030-1055 Break - Please contribute requested
amounts for coffee & donuts
1100-1200 Presentation: MicroVision
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